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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Warranty and Repair Policy

Ross Video Limited (Ross) warrants its Interstellar Production Portal Server systems to be free from defects under 
normal use and service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your Interstellar 
Production Portal Server system, contact your regional sales manager.



Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Use of Hazardous Substances in Electrical and Electronic Products (China RoHS)

Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html


Company Address

Ross Video Limited 

8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com

E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction

A Word of Thanks

Thank you for choosing Ross Video Interstellar Production Portal as your remote production management solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team is more than happy to provide further information on the plans available. 
Members of our sales team will promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of an Interstellar Production Portal remote production management solution 
from Ross Video. We are confident of your future pleasure with your choice.

Yours Sincerely,

Amanda Holtstrom
Product Manager – Interstellar Production Portal
aholtstrom@rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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About This Guide

This guide contains the following chapters that cover the installation and configuration of Interstellar Production 
Portal software:

• Chapter 1, “Introduction” summarizes the guide and provides important terms, conventions and feature 
descriptions.

• Chapter 2, “System Requirements” provides the recommended minimum hardware and software requirements 
to ensure that the Interstellar Production Portal software functions correctly.

• Chapter 3, “Software Upgrades” provides instructions on how to upgrade the Interstellar Production Portal 
software.

• Chapter 4, “Software Installation” provides instructions on how to install the Interstellar Production Portal 
software on a computer after a system re-image.

• Chapter 5, “Software Licensing” provides instructions for licensing Interstellar Production Portal software.

• Chapter 6, “System Configuration” provides instructions on how to configure Interstellar Production Portal 
software options.

If you have questions pertaining to the operation of the Ross Video product, please contact us at the numbers listed 
in the section “Contacting Technical Support” on page 1–3. Our technical staff is always available for 
consultation, training, or service.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Work Order Manager panel, click Create New Work Order.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Creating a Work Order” in the Interstellar Production Portal User 
Guide.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions

Star icons are used to identify important instructions or features. For example:

When the Interstellar Production Portal Client cannot connect to the network, a Message dialog box opens to 
report the connection problem.
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Getting Help

The Ross Video product Online Help system is accessed by selecting Help Topics from the Help menu in the 
product. Alternatively, press the F1 key while working in a client or dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help 
topics and User Guide:

• Contents — table of contents

• Index — keyword reference

• Search — full text search

• Favorites — preferred information storage and access

Ross Video product guides are also supplied as print-ready PDF files on the Ross Video product Software 
Installation DVD.

Contacting Technical Support

Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-652-4886

Toll free within North America: +1 844-652-0645

EMEA

Our EMEA center is located in Buckinghamshire, England, United Kingdom and is open Monday to Friday 8:30 
a.m. to 5:00 p.m. GMT. After hours support is provided by our North America location.

Our telephone number is: +44 (0)1189502446

International toll free: +800 1005 0100

Emergency After-hours Support

Our telephone number is: +1-613-349-0006

Toll free within North America: +1 844-652-0645

International toll free: +800 1005 0100

Online

E-mail: techsupport@rossvideo.com 

Website: use the link http://www.rossvideo.com/support/tech-support.html to open a support request.

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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System Requirements
Ross Video bases Interstellar Production Portal products on mainstream PC hardware that use the Microsoft® 
Windows® operating system. To ensure that the Interstellar Production Portal functions correctly, verify that the 
computer selected to run Interstellar Production Portal software meets the recommended requirements described in 
the following sections:

• Hardware

• Software
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Hardware

Ross Video recommends the following minimum computer hardware configuration to run Interstellar Production 
Portal software:

• CPU — quad-core Intel® Xeon® E3 with Hyper-Threading

• RAM — 32GB

• Hard Drive — Minimum 2 GB free

• LAN — 100 MB/s

Software

Ross Video recommends the following minimum computer software configuration to run Interstellar Production 
Portal software:

• Microsoft® Windows® Server 2019 64-bit English only with latest patches, or

Microsoft® Windows® Server 2016 64-bit English only with latest patches, or

Microsoft® Windows® Server 2012 R2 64-bit English only with latest patches

Interstellar Production Portal can be accessed using one of the following web browsers:

• Microsoft Internet Explorer® version 11 or greater

• Google Chrome™ browser version 51 or greater

• Mozilla Firefox® version 52 or greater

• Apple Safari® version 10.2 or greater 
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Software Upgrades
This chapter provides instructions for upgrading the Interstellar Production Portal software on your computer to the 
latest version of the Interstellar Production Portal software.

The following topics are discussed in this chapter:

• Before a Software Upgrade

• Upgrade to the Latest Interstellar Production Portal Software

• Setting a Custom Password for the Database Superuser
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Before a Software Upgrade

Before you start an upgrade of the Interstellar Production Portal software on your Interstellar Production Portal 
Server, perform the following tasks:

• Have a qualified Ross Video technician perform any required maintenance or repairs on the Interstellar 
Production Portal Server.

• Use Add/Remove Programs control panel to remove any existing version of Interstellar Production Portal 
software.

• Exit all other Windows® programs currently running on the Interstellar Production Portal Server.

• Temporarily disable anti-virus software running on the Interstellar Production Portal computer. Some 
heuristic-based intrusion detection systems prevent the upgrade of Interstellar Production Portal software. 
Re-enable anti-virus software after upgrading the Interstellar Production Portal software.

Contact a Ross Video sales representative about Interstellar Production Portal commissioning, training, and update 
services.

 After upgrading Interstellar Production Portal software, you must obtain feature licenses from Ross Video 
Technical Support before users can access Interstellar Production Portal features.

For More Information on...

• Ross Video Technical Support phone numbers, refer to the section “Contacting Technical Support” on 
page 1–3.

Upgrade to the Latest Interstellar Production Portal Software

This section provides instructions for upgrading Interstellar Production Portal software versions

When upgrading Interstellar Production Portal software, do not uninstall the Interstellar Production Portal 
Database. Interstellar Production Portal software upgrade procedures only require the uninstall of the previous 
version of Interstellar Production Portal software.

 Performance tuned Interstellar Production Portal settings must be re-tuned after a Interstellar Production Portal 
software upgrade.

To upgrade Interstellar Production Portal software

1. Use Add/Remove Programs on the Control Panel of your computer to remove the Interstellar Production 
Portal software installed on the Interstellar Production Portal computer.

2. Restart the Interstellar Production Portal computer.

3. After the Interstellar Production Portal computer restart, log in to the Interstellar Production Portal computer 
and run the Ross Interstellar Production Portal Setup wizard (Interstellar Production 
Portal-1.0.x-xxx-xxx.msi) on the Interstellar Production Portal Software DVD. For the complete 
installation procedure, refer to the chapter “Software Installation” on page 4–1.

4. After the Interstellar Production Portal computer restarts, log in to the Interstellar Production Portal computer 
and continue with one of the following:

• If your Interstellar Production Portal Database uses the standard password of postgres for the database 
superuser postgres, continue with step 5 in this procedure.

• If your Interstellar Production Portal Database does not use the standard password of postgres for the 
database superuser postgres, complete the procedure in the section “Setting a Custom Password for the 
Database Superuser” on page 3–3.
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5. Use one of the following methods to open the Interstellar Production Portal web page:

• On the Desktop, double-click the Ross Interstellar Production Portal icon.

• Use the Start menu to select All Programs > Ross Interstellar Production Portal > Ross Interstellar 
Production Portal.

The Upgrade Required web page opens in a web browser window. If the Upgrade Required web page does 
not open, contact Ross Video Technical Support.

6. Click Start Upgrade.

After the upgrade completes, the Interstellar Production Portal Login screen opens. If the Interstellar 
Production Portal Login screen does not display, contact Ross Video Technical Support.

7. Retune the Interstellar Production Portal settings by completing the procedure “To tune Interstellar 
Production Portal Server settings in the jvm.conf file:” on page 4–12.

Setting a Custom Password for the Database Superuser

During the installation of the PostgreSQL database, you must set the password for the database superuser and 
service account named postgres. If the password set for postgres is not the standard password of postgres, 
the installer must configure the Interstellar Production Portal software to use the custom postgres password.

To set a custom postgres password

1. Use one of the following methods to open the Interstellar Production Portal web page:

• On the Desktop, double-click the Ross Interstellar Production Portal icon.

• Use the Start menu to select All Programs > Ross Interstellar Production Portal > Ross Interstellar 
Production Portal.

The Interstellar Production Portal Login screen opens. If the Interstellar Production Portal Login screen 
does not open, contact Ross Video Technical Support.

2. At the Interstellar Production Portal Login screen, enter the following user name and password in the 
provided boxes:

• Username — maintenance

• Password — maintenance



3–4 • Software Upgrades Interstellar Production Portal Installation Guide (v1.0)

3. Click Login.

You are logged into the Interstellar Production Portal.

4. In the Tools section of the Interstellar Production Portal toolbar, click the  Configuration icon.

The Database tab of the Configuration panel opens.

5. In the Password box, enter the custom password set for the database superuser named postgres.

6. Click OK.

An Alert dialog box opens.

7. In the Alert dialog box, click OK.

The Alert and Configuration dialog boxes close.

8. On the Interstellar Production Portal toolbar, click the Logout icon.

A Message dialog box opens.

9. In the Message dialog box, click OK to log out of Interstellar Production Portal.

10. Close the web browser.

11. From the Windows® Desktop, press Windows Key+R.

The Run dialog box opens.

12. In the Open box, type the following application name: services.msc

13. Click OK.

The Services window opens.
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14. In the Services list, locate and select the Ross Interstellar Production Portal service.

15. Click Restart for the Ross Interstellar Production Portal service.

16. Use the File menu to select Exit.

The Service dialog box closes.

17. Use one of the following methods to open the Interstellar Production Portal web page:

• On the Desktop, double-click the Ross Interstellar Production Portal icon.

• Use the Start menu to select All Programs > Ross Interstellar Production Portal > Ross Interstellar 
Production Portal.

The Upgrade Required web page opens in a web browser window.

 If the Upgrade Required web page does not open, contact Ross Video Technical Support.

18. Click Start Upgrade.

After the upgrade completes, an Alert dialog opens with the Interstellar Production Portal Login screen. If 
the Interstellar Production Portal Login screen does not open, contact Ross Video Technical Support.

19. Retune Interstellar Production Portal settings by completing the procedure “To tune Interstellar Production 
Portal Server settings in the jvm.conf file:” on page 4–12.
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Software Installation
This chapter provides instructions for installing Interstellar Production Portal software on a Interstellar Production 
Portal computer after a system re-image.

The following topics are discussed in this chapter:

• Before a Software Install

• Installing Interstellar Production Portal Database Software

• Installing Interstellar Production Portal Software

• Setting a Custom Password for the Database Superuser

• Tuning the Interstellar Production Portal and Database for Performance
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Before a Software Install

Before you install Interstellar Production Portal software on a Interstellar Production Portal computer, perform the 
following tasks:

• Have a qualified Ross Video technician perform any required maintenance or repairs on the Interstellar 
Production Portal computer.

• Exit all other Windows® programs currently running on the Interstellar Production Portal computer.

• Temporarily disable anti-virus software running on the Interstellar Production Portal computer. Some 
heuristic-based intrusion detection systems prevent the installation of Interstellar Production Portal software. 
Re-enable anti-virus software after installing the Interstellar Production Portal software.

Contact a Ross Video sales representative for information about Interstellar Production Portal commissioning, 
training, and update services.

 After installing Interstellar Production Portal software, you must obtain Interstellar Production Portal feature 
licenses from Ross Video Technical Support before users can access Interstellar Production Portal features.

For More Information on...

• Ross Video Technical Support phone numbers, refer to the section “Contacting Technical Support” on 
page 1–3.

Installing Interstellar Production Portal Database Software

Interstellar Production Portal uses the PostgreSQL database to store and manage application data. Only the initial 
installation or recover installations of Interstellar Production Portal software on a computer require the installation 
of the PostgreSQL database software.

 You must install and configure PostgreSQL database software on the Interstellar Production Portal computer 
before installing Interstellar Production Portal on the computer.

Upgrading Interstellar Production Portal software to a new version does not require a re-installation of the 
PostgreSQL database software. For the complete upgrade procedure, refer to the chapter “Software Upgrades” on 
page 3–1.

To install PostgreSQL database software for an initial install of Interstellar Production Portal software

1. On the Interstellar Production Portal computer, exit all currently running Windows® applications.

2. Insert the Interstellar Production Portal software DVD into the DVD-ROM drive.

3. On the Desktop, open My Computer.

4. In the My Computer explorer window, open the DVD-ROM Drive.

5. Right-click the postgresql-9.3.5-3-windows-x64.exe icon and select Run as administrator from the Shortcut 
menu.
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The Setup wizard opens.

6. Click Next.

The Installation Directory dialog opens.

7. Click Next.

The Data Directory dialog box opens.

8. Replace the folder name in the Data Directory box with the following folder name:

C:\ProgramData\PostgreSQL\9.3\data 

9. Click Next.

The Password dialog box opens.
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10. In the Password box, type the following password for the data base super user named postgres:

postgres 

If the password of postgres does not meet the password security requirements set by your organization, enter 
a different password that meets the requirements. Remember to replace the password postgres with your 
password when installing, re-installing, or upgrading the Interstellar Production Portal software.

11. In the Retype Password box, type the password you set in step 10.

12. Click Next.

The Port dialog box opens.

13. Click Next.

The Advanced Options dialog box opens.

14. Use the Locale list to select [Default locale].

The [Default locale] option sets the PostgreSQL database local to the same locale set for the Windows 
operating system.

15. Click Next.

The Ready to Install dialog box opens.
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16. Click Next.

The Installing panel opens. A progress bar displays the installation status. After the installer finishes installing 
the required files, the Completing the PostgreSQL Setup Wizard dialog box opens.

17. Clear the Stack Builder check box.

Click Finish.

18. The Setup wizard closes.

To configure the data base for Interstellar Production Portal

1. From the Windows Desktop, use the Start menu to select All Programs > PostgreSQL 9.0 > pgAdminIII.

The pgAdminIII window opens.

2. In the Object Browser tree view, right-click the PostgreSQL 9.3 (localhost:5432) database and select 
Connect from the shortcut menu.

The Connect to Server dialog box opens.

3. In the Password box, type the following password:

postgres

If the password of postgres does not meet the password security requirements set by your organization, enter 
the custom password set during installation of the Interstellar Production Portal software on the Interstellar 
Production Portal computer.
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4. Click OK.

The PostgreSQL 9.0 node expands in the Object Browser tree view.

5. In the expanded PostgreSQL 9.0 node, right-click the Databases node and select New Database from the 
shortcut menu.

The New Database dialog box opens.

6. In the Name box, type the following name:

interstellar 

7. Click OK.

PostgreSQL adds the Interstellar Production Portal database to the Properties tab of the pgAdmin III window.

8. In the pgAdmin III window, use the File menu to select Exit.

The pgAdmin III window closes.

Interstellar Production Portal Service User

You must also set the user that runs the PostgreSQL database service before you install Interstellar Production 
Portal software.

To set the user that runs the PostgreSQL database service

1. From the Windows Desktop, press Windows Key+R.

The Run dialog box opens.

2. In the Open box, type the following application name:

services.msc 



Interstellar Production Portal Installation Guide (v1.0) Software Installation • 4–7

3. Click OK.

The Services window opens.

4. In the Services list, locate the postgresql-x64-9.3 service.

5. Right-click the postgresql-x64-9.3 service and select Properties from the shortcut menu.

The postgresql-x64-9.3 Properties dialog box opens.

6. Click the Log On tab.

The Log On tab opens.

7. Select the Local System Account option.

8. Click OK.

The Services alert dialog box opens.

9. In the Services alert, click OK.

The Services alert and the postgresql-x64-9.3 Properties dialog box close.

10. In the Services window, click Restart for the postgresql-x64-9.3 service.

11. Use the File menu to select Exit.

The Services window closes.
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Installing Interstellar Production Portal Software

After installing and configuring the PostgreSQL database software on the Interstellar Production Portal computer, 
you can install the Interstellar Production Portal software.

 After installing Interstellar Production Portal software, you must obtain Interstellar Production Portal feature 
licenses from Ross Video Technical Support before users can access Interstellar Production Portal features.

To install Interstellar Production Portal software

1. On the Interstellar Production Portal computer, exit all currently running applications.

2. Temporarily disable anti-virus software running on the Interstellar Production Portal computer.

Some heuristic-based intrusion detection systems prevent the installation of Interstellar Production Portal 
software.

3. Insert the Interstellar Production Portal software DVD into the DVD-ROM drive.

4. On the Desktop, open My Computer.

5. In the My Computer explorer window, open the DVD-ROM Drive.

6. Double-click Interstellar Production Portal-1.0.x-xxxx-xxxx.msi.

If a Security Warning displays, click Run.

The Ross Interstellar Production Portal Setup wizard opens.

7. Click Next.

The End-User License Agreement screen opens.

8. Read the Interstellar Production Portal Software License Grant.

9. Select the I accept the terms of the license agreement option.
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10. Click Next.

The Choose Setup Type screen opens.

11. Click the Ross Interstellar Production Portal icon.

The Ready to Install screen opens.

12. Click Install.

After installation of the Interstellar Production Portal is complete, the Installation Complete screen opens.

13. Click Finish.

The Ross Interstellar Production Portal Setup wizard closes and adds the following icons to the Desktop:

• Interstellar Production Portal Readme 

• Interstellar Production Portal Release Notes 

• Ross Interstellar Production Portal 

The Interstellar Production Portal starts automatically after the installation of the Interstellar Production Portal 
software.

14. Re-enable anti-virus software.
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15. Continue with one of the following:

• If your Interstellar Production Portal database uses the standard password of postgres for the database 
superuser postgres, do the following:

› Performance tune the Interstellar Production Portal and database by completing the procedure in the 
section “Tuning the Interstellar Production Portal and Database for Performance” on page 4–11.

› License the Interstellar Production Portal software by completing the procedures in the chapter “Software 
Licensing” on page 5–1.

• If your Interstellar Production Portal database does not use the standard password of postgres for the 
database superuser postgres, complete the procedure in the section “Setting a Custom Password for the 
Database Superuser” on page 4–10.

Setting a Custom Password for the Database Superuser

During the installation of the PostgreSQL database, you must set the password for the database superuser and 
service account named postgres. If the password set for postgres is not the standard password of postgres, 
the installer must configure the Interstellar Production Portal software to use the custom postgres password.

To set a custom postgres password

1. Use one of the following methods to open the Interstellar Production Portal web page:

• On the Desktop, double-click the Ross Interstellar Production Portal icon.

• Use the Start menu to select All Programs > Ross Interstellar Production Portal > Ross Interstellar 
Production Portal.

The Interstellar Production Portal Login screen opens. If the Interstellar Production Portal Login screen 
does not open, please contact Ross Video Technical Support.

2. At the Interstellar Production Portal Login screen, enter the following user name and password in the 
provided boxes:

• Username — maintenance 

• Password — maintenance 

3. Click Login.

You are logged into the Interstellar Production Portal.

4. In the Interstellar Production Portal toolbar, click the  Configuration icon.

The Database tab of the Configuration panel opens.

5. In the Password box, enter the custom password set for the database superuser named postgres.

6. Click OK.

An Alert dialog box opens.
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7. In the Alert dialog box, click OK.

The Alert and Configuration dialog boxes close.

8. On the Interstellar Production Portal toolbar, click the Logout icon.

A Message dialog box opens.

9. In the Message dialog box, click OK to log out of Interstellar Production Portal.

10. Close the web browser.

11. From the Windows Desktop, press Windows Key+R.

The Run dialog box opens.

12. In the Open box, type the following application name:

services.msc 

13. Click OK.

The Services window opens.

14. In the Services list, locate and select the Ross Interstellar Production Portal service.

15. Click Restart for the Ross Interstellar Production Portal service.

16. Use the File menu to select Exit.

The Services dialog box opens.

17. Performance tune the Interstellar Production Portal and database by completing the procedure in the section 
“Tuning the Interstellar Production Portal and Database for Performance” on page 4–11.

18. License the Interstellar Production Portal software by completing the procedures in the chapter “Software 
Licensing” on page 5–1.

Tuning the Interstellar Production Portal and Database for Performance

The goal of Interstellar Production Portal Server and database performance tuning is to maximize use of system 
resources to perform work as efficiently and rapidly as possible. The installation or upgrade of Interstellar 
Production Portal Server software configures the Interstellar Production Portal Server and the Interstellar 
Production Portal database to manage work efficiently, but it is possible to greatly improve performance by tuning 
the values of a few key Interstellar Production Portal Server and database settings.



4–12 • Software Installation Interstellar Production Portal Installation Guide (v1.0)

Interstellar Production Portal Server Settings

The Interstellar Production Portal Server saves configuration settings in the jvm.conf file. The settings to tune are as 
follows:

• wrapper.java.initmemory — sets the initial java heap size for the Interstellar Production Portal Server.

• wrapper.java.maxmemory — sets the maximum java heap size for the Interstellar Production Portal Server.

 You must retune Interstellar Production Portal Server settings after each install or upgrade of Interstellar 
Production Portal Server software.

To tune Interstellar Production Portal Server settings in the jvm.conf file:

1. On the Interstellar Production Portal Server computer, locate the jvm.conf file in the following folder.

C:\Program Files\Ross Video\Interstellar\configuration 

2. Use a text editor to open and edit the jvm.conf file.

3. In the jvm.conf file, locate the following setting:

wrapper.java.initmemory 

4. Replace the default memory value for the wrapper.java.initmemory setting with a tuned value. The tuned 
value for wrapper.java.initmemory depends on the software running on your Interstellar Production Portal 
Server computer and the amount of RAM installed in the computer. Use the following table to set the 
wrapper.java.initmemory value for your Interstellar Production Portal system:

5. Locate the following setting:

wrapper.java.maxmemory 

6. Replace the default memory value for the wrapper.java.maxmemory setting with a tuned value. The tuned 
value for wrapper.java.maxmemory depends on the software running on your Interstellar Production Portal 
Server computer and the amount of RAM installed in the computer. Use the following table to set the 
wrapper.java.maxmemory value for your Interstellar Production Portal system:

7. Save the updated jvm.conf file and exit the text editor.

System RAM

2 GB 4 GB 8 GB 12 GB 16 GB 32 GB

Interstellar Production Portal
Server & Database

256 512 1024 1536 2048 4096

Interstellar Production Portal
Dedicated Server

1024 2048 4096 6144 8192 16384

System RAM

2 GB 4 GB 8 GB 12 GB 16 GB 32 GB

Interstellar Production Portal
Server & Database

512 1024 2048 3072 4096 8192

Interstellar Production Portal
Dedicated Server

1536 3072 6147 9216 12288 24576
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8. Restart the Interstellar Production Portal service as follows:

a. From the Windows Desktop, press Windows Key R.

b. In the Open box, type services.msc.

c. Click OK.

d. In the Services list, locate and select the Ross Interstellar service.

e. Click Restart for the Ross Interstellar service.

f. Use the File menu to select Exit.

9. Follow the procedure in the “Database Settings” on page 4–13 section to tune the Interstellar Production 
Portal database.

Database Settings

PostgreSQL saves configuration settings in the postgresql.conf file. The settings to tune are as follows:

• max_connections — sets the maximum number of concurrent connections to the database server.

• work_mem — sets the amount of memory that the internal sort operations table and hash table use before 
switching to temporary disk files.

• shared_buffers — sets the amount of memory dedicated to PostgreSQL to use for caching data.

• effective_cache_size — sets the amount of memory available for disk caching by the operating system and 
within the database itself.

To tune database settings in the postgresql.conf file:

1. If the Interstellar Production Portal database is not running on the same computer as the Interstellar Production 
Portal Server, log into the Interstellar Production Portal database computer.

2. Stop the Interstellar Production Portal service as follows:

a. From the Windows Desktop, press Windows Key R.

b. In the Open box, type services.msc.

c. Click OK.

d. In the Services list, locate and select the Ross Interstellar service.

e. Click Stop for the Ross Interstellar service.

3. Locate the postgresql.conf file stored in the PostgreSQL data folder.

By default, the following folder contains the postgresql.conf file:

C:\ProgramData\PostgreSQL\9.3\data 

If you changed the Data Directory folder during the PostgreSQL database software install, look for the 
postgresql.conf file in the specified Data Directory folder.

4. Use a text editor to open and edit the postgresql.conf file.

5. In the postgresql.conf file, locate the following setting:

max_connections 

6. Replace the default connections value for the max_connections setting with the following tuned value:

max_connections = 200 

7. Locate the following setting:

work_mem 

8. If a # character precedes the work_mem setting, delete the # character.
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9. Replace the default memory value for the work_mem setting with a tuned value. The tuned value for 
work_mem depends on the software running on your Interstellar Production Portal Server computer and the 
amount of RAM installed in the computer. Use the following table to set the work_mem value for your 
Interstellar Production Portal system:

10. Locate the following setting:

shared_buffers 

11. If a # character precedes the shared_buffers setting, delete the # character.

12. Replace the default size value for the shared_buffers setting with the following tuned value:

shared_buffers = 512MB 

13. In the postgresql.conf file, locate the following setting:

effective_cache_size 

14. If a # character precedes the effective_cache_size setting, delete the # character.

15. Replace the default memory value for the effective_cache_size setting with a tuned value. The tuned value for 
effective_cache_size depends on the software running on your Interstellar Production Portal Server computer 
and the amount of RAM installed in the computer. Use the following table to set the effective_cache_size 
value for your Interstellar Production Portal system:

16. Save the updated postgresql.conf file and exit the text editor.

17. Restart the PostgreSQL service as follows:

a. In the Services list of the Services dialog box, locate and select the postgresql-x64-9.3 service.

b. Click Restart for the postgresql-x64-9.3 service.

18. Start the Interstellar Production Portal service as follows:

a. In the Services list of the Services window, locate and select the Ross Interstellar service.

b. Click Start for the Ross Interstellar service.

c. Use the File menu to select Exit.

System RAM

2 GB 4 GB 8 GB 12 GB 16 GB 32 GB

Interstellar Production Portal
Server & Database

4 MB 8 MB 16 MB 20 MB 24 MB 32 MB

Interstellar Production Portal
Dedicated Database

8 MB 16 MB 32 MB 40 MB 48 MB 64 MB

System RAM

2 GB 4 GB 8 GB 12 GB 16 GB 32 GB

Interstellar Production Portal
Server & Database

800 MB 1600 MB 3200 MB 4000 MB 4800 MB 6400 MB

Interstellar Production Portal
Dedicated Database

1200 MB 2400 MB 4800 MB 6000 MB 7200 MB 9600 MB
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Software Licensing
Ross Video uses a product key and feature license keys to control user access to Interstellar Production Portal 
features. You can obtain a Interstellar Production Portal product key from Ross Video Technical Support. This 
chapter provides instructions for licensing a Interstellar Production Portal.

When a Interstellar Production Portal computer has multiple active network adapters (wireless, wired, or 
multiple NIC cards), disabling an adapter after licensing the Interstellar Production Portal may invalidate your 
Interstellar Production Portal product key. To re-license your Interstellar Production Portal, restart the server and 
reactivate the product key.

The following topics are discussed in this chapter:

• Activating a Product Key for Interstellar Production Portal Software

• Reactivating a Product Key

• Deactivating a Product Key
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Activating a Product Key for Interstellar Production Portal Software

Ross Video uses product keys to manage user licenses for Interstellar Production Portal features. You can obtain a 
Interstellar Production Portal product key from Ross Video Technical Support.

When you activate a Interstellar Production Portal software product key, your Interstellar Production Portal 
computer must contact the Ross Video Activation Server through the internet.

To activate a Interstellar Production Portal product key

1. Verify that the Interstellar Production Portal computer can connect to the Internet.

2. Use one of the following methods to open the Interstellar Production Portal web page:

• On the Desktop, double-click the Ross Interstellar Production Portal icon.

• Use the Start menu to select All Programs > Ross Interstellar Production Portal > Ross Interstellar 
Production Portal.

An Alert dialog box opens with the Ross Interstellar Production Portal web page.

 If the Ross Interstellar Production Portal web page does not open, contact Ross Video Technical Support.

3. In the Alert dialog box, click OK.

The Alert dialog box closes.

4. At the Interstellar Production Portal Login screen, enter the following user name and password in the 
provided boxes:

• Username — root 

• Password — password 

5. Click Login.

You are logged into the Interstellar Production Portal as an administrator.

 If a message displays indicating that the system is in maintenance mode, Interstellar Production Portal cannot 
communicate with the database. Contact Ross Video Technical Support.

6. In the Tools section of the Interstellar Production Portal toolbar, click the  Configuration icon.

The Configuration panel opens.
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7. Click the Licensing tab.

The Licensing Configuration tab opens.

8. Obtain a Interstellar Production Portal product key from Ross Video Technical Support. 

9. In the Product Key box, enter the product key obtained from Ross Video Technical Support.

10. Click Activate.

After activating the entered product key, an Alert dialog box opens requesting a web browser window refresh.

11. Click OK

The Alert dialog box closes and the Licensing Configuration tab updates to display the new feature licenses 
associated with the activated product key. The Status column displays one of the following states:

12. Click OK.

The Configuration dialog box closes.

13. Refresh your web browser window.

Interstellar Production Portal add icons to the toolbar for the newly activated features, making the features 
accessible to Interstellar Production Portal users.

For More Information on...

• Ross Video Technical Support phone numbers, refer to the section “Contacting Technical Support” on 
page 1–3.

Background Status Description

 Green Active The feature is active and available to Interstellar Production Portal 
users.

 Yellow Expires in # days The feature availability for Interstellar Production Portal users 
expires in the displayed number of days.

 Red Expired The feature has expired and is no longer available to Interstellar 
Production Portal users.

 Red Invalid MAC The feature license key is invalid for the active network interface 
card of the Interstellar Production Portal computer.

 White Not Purchased The feature is not accessible to Interstellar Production Portal users, 
but it is available for purchase.
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Reactivating a Product Key

After purchasing new features for a Interstellar Production Portal system, the Interstellar Production Portal product 
key requires a reactivation to make the purchased features available to Interstellar Production Portal users.

To reactivate a Interstellar Production Portal product key

1. Log in to Interstellar Production Portal as an administrator.

2. In the Tools section of the Interstellar Production Portal toolbar, click the  Configuration icon.

The Configuration window opens.

3. On the Configuration window toolbar, click the  System icon.

The System panel opens.

4. Click the Licensing tab.

The Licensing Configuration tab opens.

5. Click the License Options link.

 The Product Key field displays the currently activate product key.

6. Click Reactivate.

After reactivating the product key, an Alert dialog box opens requesting a refresh of the web browser window.

7. Click OK.

The Alert dialog box closes, and the Licensing Configuration tab is updates to display with new feature 
licenses associated with the reactivated product key.

8. Click OK.

The Configuration dialog box closes.

9. Refresh your web browser window.

Interstellar Production Portal adds icons to the toolbar for the newly activated features, making the features 
accessible to Interstellar Production Portal users.

Deactivating a Product Key

When you want to move Interstellar Production Portal software on another computer, you must find deactivate the 
Interstellar Production Portal software on the current Interstellar Production Portal computer.

To deactivate a Interstellar Production Portal product key

1. Log in to Interstellar Production Portal as an administrator.

2. In the Tools section of the Interstellar Production Portal toolbar, click the  Configuration icon.

The Configuration window opens.

3. On the Configuration window toolbar, click the  System icon.

The System panel opens.

4. Click the Licensing tab.

The Licensing Configuration tab opens.

5. Click the License Options link.

 The Product Key field displays the currently activate product key.
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6. Click Deactivate.

After deactivating the product key, an Alert dialog box opens.

7. Click OK.

The Alert dialog box closes, and the product key shown in the Product Key box deactivates. You can use the 
deactivated product key to activate Interstellar Production Portal software on another computer.

Deactivating a product key unlicenses and removes Interstellar Production Portal user access to all the 
Interstellar Production Portal features associated with the product key.

8. Click OK.

The Configuration dialog box closes.
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System Configuration
The following topics are discussed in this chapter:

• Changing the Root User Password

• Accessing the Configuration Interface

• Changing the Interstellar Production Portal Wallpaper
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Changing the Root User Password

For security reasons, we recommend you change the default root user password.

To change the root user password

1. Log in to Interstellar Production Portal.

2. In the Tools section of the Interstellar Production Portal toolbar, click the  Change Password icon.

The Change Password panel opens.

3. In the Old Password box, type the root user password:

password 

4. In the New Password box, type a new password that you can remember.

5. In the Verify Password box, type the new password again.

6. Click Change Password.

The login password for the root user changes to the newly set password.

Accessing the Configuration Interface

Use the Configuration interface to set up user accounts, user roles, and system properties. Refer to the Interstellar 
Production Portal Configuration Guide for more details.

To access the Configuration interface

1. Log in to Interstellar Production Portal.

2. In the Tools section of the Interstellar Production Portal toolbar, click the  Configuration icon.

The Configuration panel opens.

Changing the Interstellar Production Portal Wallpaper

You can set up the Interstellar Production Portal wallpaper graphic to appear as your Interstellar Production Portal 
desktop background image. The Interstellar Production Portal wallpaper features the Interstellar Production Portal 
logo, and clearly identifies the computer as a Interstellar Production Portal.

To install Interstellar Production Portal wallpaper

1. On the Interstellar Production Portal computer, open either Microsoft® Internet Explorer® or Google® 
Chrome®, and then navigate to:

http://localhost/resources/Interstellar Production 
Portal/images/wallpaper/1920x1080.jpg 

The wallpaper image opens in the web browser.

2. If you want to replace your current Desktop background image with the Interstellar Production Portal 
wallpaper, do one of the following:

• In Internet Explorer — right-click the wallpaper graphic file and then click Set as background.

• In Chrome — right-click the wallpaper graphic and then click Save image as....Save the image to your 
Desktop. Navigate to the image, right-click it, and then click Set as Desktop background.
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